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Part A:  Organizing Information 
Overview of an Excel Spreadsheet 

 

 

 

 
 

1) The Window 

Toolbars 

Formula bar:  Shows the information contained in a cell 

Workbook window:  Contains the workbook where you will enter the data and formulas that make up 
your workbook 

 

2) Workbook Window 

Tabs:  A workbook consists of 3 worksheets, each of which can contain thousands of cells.  You can use 
the tabs to flip worksheets. 

Column heading:  Identifies the column by letters 

Row heading:  Identifies the row by numbers 

Selector:  Outline that indicates the active cell 

 

Menu bar 

Standard toolbar 
Formatting toolbar 

Formula bar 

Column headings 

Status bar 
Worksheet tabs 

Row headings 

Active cell--indicated by 
thick black outline 

Split bars 

Tab scrolling buttons 

Split bars 
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3) Cell 

When a row and a column intersect, they form a box called a cell.  Each cell has an address that consists 
of the column letter and row number (A2, C14, D7, etc.).  You enter data and formulas in the cells of your 
worksheets. 

 

4) Types Of Data That You Can Enter 

Text (automatically left-aligned) Times 

Numbers (automatically right-aligned) Formulas and functions 

Dates 

  

5) Entering Text And Numbers 

a) Select the cell 
b) Type the text 

c) Hit the Enter  or Return key to move down, or hit the Tab key to move to the next cell to the right 
 

6) Adjusting Column Width 

a) Select the entire column by clicking on its letter name at the top and then adjust column width by 
grabbing either end of the column and moving it  OR 

b) Select column(s); right-click and select Column Width  
c) Type the number of characters desired OR 

d) Select column(s); Format, Column, Width  

e) Type the number of characters desired or select AutoFit 

 

7) Adjusting Row Height 

a) Select the row by clicking on its number along the left-hand side and then adjust its height by grabbing 
either the top or bottom of the row and moving it  OR 

b) Select row(s); right-click and select Row Height OR 
c) Type the desired height in points 

d) Select row(s); Format, Row, Height 

e) Type the desired height in points or select AutoFit    
 

8) Entering Data More Quickly:  The Fill Command 

a) Select the cell to be copied 
b) Position the mouse pointer over the selected cell 
c) Drag the fill handle (cursor turns into a small black cross) in the lower right corner of the selected cell 

to highlight the cells into which you want to copy the entry and release the mouse button.  
 

9) Series 

a) Enter the first two values of the series 
b) Select the two cells by grabbing the fill handle in the lower-right corner (the cursor turns into a small 

black cross) and then drag across to highlight the cells into which you want to extend the series 
c) When you release the mouse button, the series should fill in correctly   OR 
d) Enter a starting value in one cell 
e) Select cells into which you want to extend the series (the original value will be copied into those cells) 

f) Click on Edit on the Menu Bar, select Fill, Series 

g) Under “Series in,” select Rows or Columns 

h) Under “Type,” choose a series type 
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i) Adjust the Step value (amount between each series value) and Stop value (last value you want Excel 
to enter), if necessary 

j) Click OK or Enter 
 

Series Initial selection Extended series 

Linear:  increases or decreases 
values by a constant value 

1, 2 
1, 3 
100, 95 

3, 4, 5 
5, 7, 9 
90, 85, 80 

Growth:  multiplies values by 
a constant factor 

2 (step value 4) 
3 (step value 3) 

8, 32, 128 
9, 27, 81 

Date:  increases days/weeks/months/years by a value that you set 

AutoFill:  logically repeats 
some series 

Qtr 3 
1st Period 

Qtr 4, Qtr 1, Qtr 2 
2nd Period, 3rd Period 

 

10) AutoFill 

a) To enter a series such as the days of the week, type Monday into a cell 
b) Drag the fill handle in any direction to select six more cells 
c) Release the mouse button 
d) Excel inserts the remaining days of the week, in order, into the selected cells. (You can also AutoFill 

the months.) 
 

11) Making Your Own Series 

a) Click on Tools on the Menu Bar, select Options 

b) Select the Custom Lists tab; click the Add button 
c) Type the entries you want to use for your AutoFill entries (Ardmore, Bennett, Cherry Crest, etc.).  

Press Enter at the end of each entry.  If you don’t press Enter, Excel will not read the items as separate 
entries. 

d) Click OK. 
e) Type any item in the list and use AutoFill to insert the remaining entries. 

Note: type the whole series into a worksheet, select the cells, select Tools, Options, click on the Custom 

Lists tab, then click on the Import button 
 

12) Formatting Cells for Data 

When data is entered in a cell, it is automatically right aligned.   
If a certain type of entry is to be made in one cell or a group of cells, preselecting the cell formatting can 

be done by using the Format Cells command. 
a) Select the whole area where you will want this formatting applied. 

b) Right-click and select Format Cells… from the shortcut menu; OR click on Format on the Menu 

Bar and select Cells OR press Ctrl+1  

c) Click Number tab; select a category and the available formatting options will appear on the right-hand 
side of the dialogue box.  Below is a brief look at some of the options in these categories: 

Number:  number of decimal places, how to format negatives, use of comma 

Currency:  number of decimal places, how to format negatives, use of comma 

Accounting:  number of decimal places 

Date:  type 

Time:  type 

Special:  specific formatting like ZIP code, phone number, Social Security number 

Custom:  build your own format from existing codes displayed on the list 
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13) Adding Color to Text and Background 

a) Click on cell containing text to change 

b) Click on the Font Color icon on the formatting toolbar OR  Click on Format on the Menu Bar, select 

Cells and click on the Font tab and select color 

c) To add a background fill color click on the Fill Color icon on the formatting toolbar OR  Click on 

Format on the Menu Bar, select Cells and click on the Patterns tab and select cell shading color.  

 
 
 

14) Editing Data 

a) Double-click on the cell  

b) Edit data, then press Enter 

 

15) Undoing An Action 

a) Click on Edit on the Menu Bar, select Undo or Ctrl+Z   or click on the Undo button with the 
counterclockwise arrow on it. 

b) EXCEL will undo up to 16 actions  
 
 
 

16) Copying Data 

a) Select information to be copied (single or multiple cells) 

b) Click on Edit on the Menu Bar, select Ctrl+C or click the Copy button on the 
toolbar  

c) Select first cell of area into which copy will be placed 

d) Click on Edit on the Menu Bar, select Paste or Ctrl+V  or click the Paste button on the toolbar 
 

17) Erasing Data 

a) Select the cells you want to clear/delete 

b) Edit, Clear…, then select from the menu to delete the contents or formatting of the cells 

c) Edit, Delete to remove the cells themselves and everything in them; a dialogue box will appear asking 
if you want to delete the entire row/column, and how you want to move the remaining cells 

 

18) Inserting Cells 

a) Select cell(s) where new cell(s) will be inserted.  Excel will inset the same number of cells as selected. 

b) Right-click and select Insert… from the shortcut menu, or click on Insert and select Row or Column 
c) Select the appropriate options from the dialogue box that appears  OR 
d) Select cell(s) where new cell(s) will be inserted.  Excel will inset the same number of cells as selected 

e) Click on Insert in the Menu Bar and select Cells 

f) Select the appropriate options from the dialogue box  
 

19) Inserting Rows And Columns 

a) Select the number of rows or columns to insert by clicking on the column or row heading 

b) Right click and select Insert  OR 

c) Select the number of rows or columns to insert by clicking on the column or row heading 

d) Click on Insert in the Menu Bar and select Rows or Columns 

Undo button 

Paste button 

Copy button 

Fill Color 
Button 

Font Color 
Button 
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20) Deleting Cells 

a) Select the range of cells to delete 

b) Right click and select Delete 
c) Select option from dialogue box that pops up OR 
d) Select the range of cells to delete 

e) Click on Edit in the Menu Bar and select Delete 

f) Select option from dialogue box that pops up 
 

21) Deleting Rows And Columns 

a) Click on the row or column heading that you want to delete 

b) Right-click and select Delete OR 
c) Click on the row or column heading that you want to delete 

d) Click on Edit in the Menu Bar and select Delete 

 

22) Merging Cells  (Merge and Center)  

a) Enter Text into upper-leftmost cell that is to be merged and centered 
b) Select the cells you want to merge. 

c) To merge cells in a row or column and center the cell contents, click Merge and Center 
on the formatting toolbar 

 

23) Changing Text Direction in a Cell 

a) Click on cell containing text to change 

b) Click on Format on the Menu Bar, select Cells and click on the Alignment tab 
c) Select the amount of degrees for the text direction 
d) Click OK; text will be changed 

 

24) Wrapping text within a cell.  

a) Click on cell containing text to change 

b) Click on Format on the Menu Bar, select Cells and click on the Alignment tab 

c) Under text control check Wrap Text 
Note:  It may be necessary to adjust the row height on the cell you wish to wrap text in. (See #21).   

 

25) Adding Borders  

The gridlines that surround each cell when you’re working on the screen don’t always show up so well on 
the printed version.  To have clearer lines, add borders by selecting the cells that will have a border around 
them 

a) Click on Format, then Cells 

b) Click on Borders tab and choose desired options 
c) Alternatively use the border icon on the formatting toolbar  
 

26) Hide Gridlines 

You can hide the gridlines to check out how your new borders will look. 

a) Tools, Options 

b) Click on the View tab; select Gridlines (removes the X from the check box) 
c) To prevent gridlines from printing (but still see them on the screen): 

d) File, Page Setup 

e) Click on the Sheet tab; delete the X from the Gridlines check box 

Merge and 
Center button 

Add Borders 
Button 



Introduction to Excel 2003 Part A (pgs 1-7) & B (pgs 8-15) 

Instructional Technology, Bellevue School District 10/10/05 Page 6 of 15  6 

27) Printing Gridlines 

 By default, Excel will does not print the gridlines.   
a) Click the worksheet 

b) On the File menu, click Page Setup, and the click the Sheet tab. 

c) Select or clear the Gridlines check box.  

d) Click Print 
  

28) Adding a comment  

You can insert useful information that will pop up whenever the cursor is positioned over the cell. 
a) Select the desired cell. 
b) Right click and select Insert Comment 
c) Type the desired text 
 

29) Adding a textbox  
(Useful for adding directions or notes about the spreadsheet.  These textboxes can be colored  and moved       
about the worksheet) 

a) Turn on the Drawing Toolbar (View, Toolbars, Drawing).  
b) Select the textbox icon.  
c) Click and drag on the spreadsheet to size the textbox 
d) Click inside the textbook and enter text.  
e) Format the textbox properties (font and background coloring) by double clicking on a corner of the 

textbox.   
 

30) Viewing Data: Sorting 

a) Select the data to be sorted 
b) Click on Data on the Menu Bar and select Sort 
c) If you have selected the header row, click the button next to Header Row at the bottom of the dialog 

box 
d) Click on the box under Sort by: and select the column that is to be sorted 
e) If secondary sorts are desired, click on Then by: an select the next column to be sorted 
f) Click on Sort 

 

31) Using AutoFilter (most useful in isolating data based on particular data in one column)  
a) Select the Header Row 
b) Click on Data on the Menu Bar, select Filter and choose Auto Filter; down-arrows will appear next to 

the selected cells in the Header Row 
c) Click on the arrow next to the column that is to be filtered, and identify the cell data to be filtered; 

only the rows with that data will appear 
d) To show all contents, click on Data on the Menu Bar, select Filter and choose Show All 
 

32) Finding and Replacing Text or Numbers  

(Use this feature if you have a large database and you can’t manually find a cell that contains text or a   
number you need to edit).   

a) To search the entire worksheet, select any single cell. To search a range of cells, select that range only.  

b) Choose Edit, Find to display the Find And Replace dialog box.  
c) In the Find What text box, enter the text or number you want to search for.   

d) Click Find Next.   
e) When you are done with your search , click Close to return to your spreadsheet.    

Textbox 
Button 
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33) Page setup 

Before printing, you need to make sure your page is set up correctly. 

File, Page Setup; click on desired tab (Page, Margins, Header/Footer, Sheet) and choose appropriate 
options 

Page tab:  lets you change the orientation of the page, reduce or enlarge your workbook, change the size 
of paper used for printing, adjust the print quality if you’re printing a draft, and set the starting page 
number to something besides 1. 

Margins tab:  lets you adjust all the margins, specify how far from the edge the footer should be printed, 
or center the workbook on the page. 

Header/Footer tab:  lets you add a header or footer to further customize your workbook 

Sheet tab:  lets you print only a portion of a worksheet, specify how to print certain aspects of the 
workbook, determine page order, or use titles. 

 

34) Viewing Page Breaks and Setting Print Area 

a) Click on View, Page Break Preview 

b) You can drag the page breaks to desired locations 
c) Select the cells to be printed  
d) Click on File on the Menu Bar, choose Print Area and select Set Print Area 
Note:  Select View, Normal to exit the page break preview mode.  

 

35) Printing 

a) File, Print Preview to see how your workbook looks 

b) File, Print 
c) The Print box gives you a number of options, including printing only selected sheets, number of 

copies, page range.  From the Print box you can also choose Page Setup, Print Preview, Printer 

Setup, or Help 

 

 

36) Mail Merge   

You can use Microsoft Word in conjuction with Microsoft Excel to merge the components of a database 
into a form letter or envelopes.   
a) Create and save an excel spreadsheet with the desired data fields.   

b) Open Microsoft Word and select Tools, Letters and Mailings, Mail Merge Wizard 
c) On step 3 of the wizard, when selecting recipients choose  “Use and Existing List”  
d) Click on “Browse” and navigate to your saved Excel Spreadsheet 
e) On the Select Table dialog box select “Sheet1$” 
f) Follow steps 4-6 of the wizard to compose and merge your contacts.    
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Part B:  Using and Interpreting Data 
Overview of an Excel Spreadsheet 

 

 
 

Tips on Selecting Cells:  

• To select an individual cell click on the cell and it will be highlighted  

• To select a group of adjacent cells click and drag across the desired region 

• To select non adjacent cells hold the Ctrl button and click on desired cells.   
 

1) Types Of Data That You Can Enter 

Text (automatically left-aligned) Times 

Numbers (automatically right-aligned) Formulas and functions 

Dates 

  

2) Formatting Cells for Data 

When data is entered in a cell, it is automatically right aligned.   
If a certain type of entry is to be made in one cell or a group of cells, preselecting the cell formatting can 

be done by using the Format Cells command. 
a) Select the whole area where you will want this formatting applied. 

b) Right-click and select Format Cells… from the shortcut menu; or click on Format on the Menu Bar 

and select Cells or click Ctrl + 1.   

Chart Wizard AutoSum 
& Sort 

Formula Bar 
and Result 

Drawing Toolbar 
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c) Click Number tab; select a category and the available formatting options will appear on the right-hand 
side of the dialogue box.  Below is a brief look at some of the options in these categories: 

 

Number:  number of decimal places, how to format negatives, use of comma 

Currency:  number of decimal places, how to format negatives, use of comma 

Accounting:  number of decimal places 

Date:  type 

Time:  type 

Special:  specific formatting like ZIP code, phone number, Social Security number 

Custom:  build your own format from existing codes displayed on the list 
 

3) Entering Data More Quickly:  The Fill Command 

a) Select the cell to be copied 
b) Position the mouse pointer over the selected cell 
c) Drag the fill handle (cursor turns into a small black cross) in the lower right corner of the selected cell 

to highlight the cells into which you want to copy the entry and release the mouse button.  
 

4) Series 

a) Enter the first two values of the series 
b) Select the two cells by grabbing the fill handle in the lower-right corner (the cursor turns into a small 

black cross) and then drag across to highlight the cells into which you want to extend the series 
c) When you release the mouse button, the series should fill in correctly   OR 
d) Enter a starting value in one cell 
e) Select the cells into which you want to extend the series (the original value will be copied into those 

cells) 

f) Click on Edit on the Menu Bar, select Fill, Series 

g) Under “Series in,” select Rows or Columns 

h) Under “Type,” choose a series type 

i) Adjust the Step value (amount between each series value) and Stop value (last value you want Excel 
to enter), if necessary 

j) Click OK or Enter 
 

Series Initial selection Extended series 

Linear:  increases or decreases 
values by a constant value 

1, 2 
1, 3 
100, 95 

3, 4, 5 
5, 7, 9 
90, 85, 80 

Growth:  multiplies values by 
a constant factor 

2 (step value 4) 
3 (step value 3) 

8, 32, 128 
9, 27, 81 

Date:  increases days/weeks/months/years by a value that you set 

AutoFill:  logically repeats 
some series 

Qtr 3 
1st Period 

Qtr 4, Qtr 1, Qtr 2 
2nd Period, 3rd Period 

 

5) AutoFill 

a) To enter a series such as the days of the week, type Monday into a cell 
b) Drag the fill handle in any direction to select six more cells 
c) Release the mouse button 
d) Excel inserts the remaining days of the week, in order, into the selected cells. (You can also AutoFill 

the months.) 

Copy button 
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6) Making Your Own Series 

a) Click on Tools on the Menu Bar, select Options 

b) Select the Custom Lists tab; click the Add button 
c) Type the entries you want to use for your AutoFill entries (Ardmore, Bennett, Cherry Crest, etc.).  

Press Enter at the end of each entry.  If you don’t press Enter, Excel will not read the items as separate 
entries. 

d) Click OK. 
e) Type any item in the list and use AutoFill to insert the remaining entries. 

Note: type the whole series into a worksheet, select the cells, select Tools, Options, click on the Custom 

Lists tab, then click on the Import button 
 

7) Viewing Data:  Splitting the Worksheet  
When there are column or row headings followed by many entries that extend well beyond the screen, it is 
often helpful to split the sheet so that the headings stay in place and the rest of the sheet can scroll.  To 
split the worksheet: 

a) At the top of the vertical scroll bar or at the right end of the horizontal scroll bar, 
point to the split box.  

b) When the pointer changes to a split pointer,   drag the split box down or 
to the left to the position you want. The worksheet is now split.  Scrolling will allow 
the Header Row to show, and the rest of the worksheet to scroll. 

 

8) Viewing Data:  Freezing Panes  

The advantage of freezing panes is that it allows you to keep some information (categories, budget 
numbers, etc.) on the screen at all times, while you enter data in another part of your workbook.  You can 
choose to freeze panes after you have split the worksheet, or you can click on a cell at the spot where you 
want the split to occur, and then follow the procedure below: 

a) Window, Freeze Panes 

b) To turn off the freeze panes feature: 

c) Window, Unfreeze Panes 

 

9) Viewing Data: Sorting 

a) Select the data to be sorted 
b) Click on Data on the Menu Bar and select Sort 
c) If you have selected the header row, click the button next to Header Row at the bottom of the dialog 

box 
d) Click on the box under Sort by: and select the column that is to be sorted 
e) If secondary sorts are desired, click on Then by: an select the next column to be sorted 
f) Click on Sort 

 

10) Using AutoFilter (most useful in isolating data based on particular data in one column)  
a) Select the Header Row 
b) Click on Data on the Menu Bar, select Filter and choose Auto Filter; down-arrows will appear next to 

the selected cells in the Header Row 
c) Click on the arrow next to the column that is to be filtered, and identify the cell data to be filtered; 

only the rows with that data will appear 
d) To show all contents, click on Data on the Menu Bar, select Filter and choose Show All 
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11) Protecting Your Speadsheet 

If you would like to protect your spreadsheet from 
modification or limit its modifications to certain users.  

a) Choose Tools, Protection, Protect Sheet 
b) Check the appropriate actions you would like users 

to be able to do 
c) Add a password if desired.  Click OK 

d) To turn off Spreadsheet Protection, to to Tools, 

Protection, Unprotect Sheet 
Note:  If you want certain cells within a protected 
worksheet available for modifying, right click on that 

cell, choose format cell, protection and uncheck 

locked. 
 

 
 

12) Page setup 

Before printing, you need to make sure your page is set up correctly. 

File, Page Setup; click on desired tab (Page, Margins, Header/Footer, Sheet) and choose appropriate 
options 

Page tab:  lets you change the orientation of the page, reduce or enlarge your workbook, change the size 
of paper used for printing, adjust the print quality if you’re printing a draft, and set the starting page 
number to something besides 1. 

Margins tab:  lets you adjust all the margins, specify how far from the edge the footer should be printed, 
or center the workbook on the page. 

Header/Footer tab:  lets you add a header or footer to further customize your workbook 

Sheet tab:  lets you print only a portion of a worksheet, specify how to print certain aspects of the 
workbook, determine page order, or use titles. 
 

13) Print Gridlines 

By default the gridlines do not print on your Excel spreadsheet.  In order to print gridlines 

a) File, Page Setup 

b) Click on the Sheet tab, check the X from the Gridlines check box.  
 

14) Hide Gridlines 

You can hide the gridlines to check out how your new borders will look. 

f) Tools, Options 

g) Click on the View tab; select Gridlines (removes the X from the check box) 
 

15) Setting Print Area 

a) Select the cells to be printed 
b) Click on File on the Menu Bar, choose Print Area and select Set Print Area 
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16) Printing 

a) File, Print Preview to see how your workbook looks 

b) File, Print 
c) The Print box gives you a number of options, including printing only selected sheets, number of 

copies, page range.  From the Print box you can also choose Page Setup, Print Preview, Printer 

Setup, or Help 
 

 
 

Anatomy of the Formula Bar 
 
 
 
 
 
 
 
 
 
 
 

17) What Is A Formula?  

a) A formula is a calculation performed on the data you enter (multiplication, division, addition, 
subtraction, etc.).  Formulas usually consist of one or more cell addresses and mathematical operators.  
In Excel, a formula should start with an equal sign (=). 

b) The formula for:  (examples) 
i) Adding is:  =A3+A4  or  =sum(A3, A4) Cells can be entered or clicked on, followed by Return 
ii) Adding a series of numbers:  =sum(A3:A5) This requires the use of “sum” and parentheses  ( the : 

means “through”, or adding A3, A4 and A5) 
iii) Subtracting is:  =A3- A4  or  =sum(A3-A4)  Cells can be entered or clicked on, followed by 

Return 
iv) Multiplying is:  =A3*A4  or   =sum(A3*A4)  Cells can be entered or clicked on, followed by 

Return 
v) Dividing is:  =A3/A4  or  =sum(A3/A4)  Cells can be entered or clicked on, followed by Return 

c) Use the AutoSum tool to add a series of numbers  
i) Click on cell that is beneath a series of cells to be added 
ii) Click on AutoSum tool; formula will automatically be created and the sum displayed 

 
 
 
 
 
 
 
 
 
 

This drop-down box contains a list 
of commonly-used functions 

Click here to reject a formula 

Click here to accept a formula 

Click on the equals sign to start a formula and open the formula bar 

Click on the function button to open the function wizard window 
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18) Order Of Operations  

Excel performs operations from left to right in the following order, giving some operators precedence over 
others: 

 

1st 2nd 3rd 
Exponential equations Multiplication and division Addition and subtraction 

 
Operations within parentheses are performed first, so you can use parentheses to change the order of 
preference, if necessary, in your formula.  For example: 
=B2*B3+B4 will give you a different result than 
=B2*(B3+B4) 

 

19) AutoSum Tool 

If you’re doing simple addition on a row/column of numbers, Excel provides a shortcut button to speed up 
the process. 
a) Select the cell where the sum is to be inserted 

b) Click on the AutoSum button 
c) Adjust the range of cells, if necessary 

d) Enter (remember, the formula won’t take if you don’t press Enter!) 

Note:  AutoSum automatically uses the numeric values in the cells directly above where it is placed.  If 
there are no numeric values in the cells above it, it will use the numeric values in the cells to the left.  If 
you want to sum a collection of cells and some of the cells happen to be blank, AutoSum may not work.  It 
usually works best if all the cells have a number or zero in them.  To be safe, always double-check what 
cells have been selected! 

 

20) Entering Formulas 

There are a few ways to enter formulas:  
a) Select the cell where calculation is to appear 
b) Type the equal sign (=)  and then type the formula followed by the 

cell parameters (i.e. =difference(A7 – B7)).  
 

Alternatively 
a) Select the cell where the calculation is to appear 
b) Click on the Insert Function icon  to the left of the 

formula bar 
c) Select a function from the drop down menu or type a 

brief description of what you want to do and then 
click Go.   

 
 
 
 
 
 
 
 
 

AutoSum button 
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21) Functions 

These are commonly-used formulas that Excel has built into its system.  To use one you specify the 
function command and then give the appropriate cell references for where you want the function 
performed.  AutoSum is one example of a function. 
To choose from a list of available functions, click on the list of 
functions in the Formula bar or click on the Function wizard button 
Once you select the function name, a dialogue box appears explaining the required parts of the function.  
A help button appears in the lower-left corner, and the tentative result appears in the middle near the 
bottom.  When you have completed all necessary parts of the function click on OK to return to the regular 
screen. 
Some of the most frequently-used options in the Function wizard include: 

Sum:  adds all the numbers in a range of cells 

Average:  returns the average (arithmetic mean) of its argument, which can be numbers, names, arrays, 
etc. 

If:  returns one value if a condition you specify evaluates to true, and returns another value if a condition 
you specify evaluates to false 

Max:  returns the largest value in a set of values (ignores text and logical values) 

Today:  returns a number that represents today’s date 
To use a function wizard: 
a) Click on the button and select the desired function 
b) Click OK after the explanatory dialogue box appears 
c) If you already know the name of the function, you can type it into the box along with your range of 

cells, following the sample format:  =average(B10:B20) 

 

22) Common Errors  

a) Do not try to divide by zero or a blank cell. 
b) Do not delete a cell that’s being used in a formula. 

 

23) Where The Formula Will Be Visible 

You can’t see the formula in the cell, only the results of the calculation.  The formula will be visible in the 

formula bar.  If you want to see the formula in the cell:  Tools, Options.  Click on the View tab.  Click on 

the Formulas check box under the “Window Options” section (an X will appear).  Click on OK to exit. 
 

24) Editing Formulas 

a) Select the cell and then Double-click on the cell 
b) Edit the formula either by typing in the cell or by typing in the formula bar  

c) Hit the Enter key to make Excel accept the changes 
 
 
 
 
 
 
 
 
 

Function wizard 
button 
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25) Graphing Data:  Using the Chart 

Wizard 

It is useful and easy to display your 
data visually using the chart wizard in 
Excel.   
a) Select the worksheet data to be 

charted.  
NOTE:  (If the worhskeet data you 
wish to use includes non-adjacent 
ranges, press and hold the Ctrl button 
as you select the desired cells).   
b) Click the Chart Wizard button.   
c) Use the Chart Wizard to specify the 

choices for your chart.   

 

 

 
 
 
 

26) Graphing Data:  Modifying Your Chart 

You can customize your chart as you like by relocating or removing the legend, changing column titles or 
even the colors of the individual bars.   
a) Right Click on the item from your chart that you want to modify  
b) Choose format 
Note:  The format choice will change depending on what item you have selected.  For example if you 
select the legend, the shortcup menu will be Format Legend.  If you right click on the chart area, the 
shortcut choice will be Format Chart Area.  
c)  For more options in changing chart titles, axes, gridlines, legends and data labels click on the chart one 

time and then choose the Chart menu Chart Options  

 
 

 

Chart Wizard Button 

Chart Wizard Button 


